
Understanding BIM

“A great building must begin with the unmeasurable, must go through measurable means

when it is being designed and in the end must be unmeasurable.”—LOUIS KAHN

Building Information Modeling is an emerging approach

to the design, analysis, and documentation of buildings. At its core, BIM is about the

management of information throughout the entire lifecycle of a design process, from

early conceptual design through construction administration, and even into facilities

management. By information we are referring to all the inputs that go into a building

design: the number of windows, the cost of materials, the size of heating and cooling

equipment, the total energy footprint of the building, and so on. This information is cap-

tured in a digital model that can then be outputted as coordinated documents, be shared

across discipline, and serve as centralized design management tool. With a tool like Revit,

you will reap the benefits of fully coordinated documents, but this represents just the tip

of the BIM iceberg. 

Implementing BIM requires careful planning if you are to achieve successful and pre-

dictable results. In this chapter, we’ll present the basics of BIM and summarize how BIM

differs from traditional drafting–based methodologies. We will explain the key character-

istics of Revit, and how Revit is truly designed to deliver the benefits of Building Informa-

tion Modeling.

Topics we’ll cover include:

■ A brief history of architectural documentation

■ Advantages of a BIM approach

■ How BIM is different from CAD

■ Why Revit?

■ Revit Concepts

■ Types of elements in Revit

■ Tips for getting started in Revit
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A Brief History of Architectural Documentation
The production of design documents has traditionally been an exercise in drawing lines to

represent a building. These documents become instruction sets: an annotated booklet that

describes how the building is to be built. The Plan, Section, and Elevation: all skillfully

drafted, line by line, drawing by drawing. Whether physical or digital, these traditional

drawing sets are composed of graphics—where each line is part of a larger abstraction

meant to convey design intent so that a building can eventually be constructed. When

Filippo Brunelleschi drew the plans for Santa Maria del Fiore (Figure 1.1) in Renaissance

Italy, the drawings represented ideas of what the building would look like. They were sim-

plified representations of a completed project, used to convey ideas to the patron. In those

days, the architect also played the role of builder, so there was no risk of losing informa-

tion between the documentation of the building and actually building it. This was the age

of the master builder, where architect and builder shared the same responsibility and

roles. Even so, Brunelleschi still needed to communicate his vision to his patrons and his

workers, and produced not only beautiful drawings, but also built elaborate scale models

so that others could easily visualize the project.

Figure 1.1

Santa Maria del

Fiore; image courtesy
of Laura Lesniewski
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As buildings became more and more complex, specialization in the design and construc-

tion process emerged. In turn, this led to the need for more elaborate forms of information

exchange. One person was no longer responsible for both the design and construction

phases, so it became necessary for designers to convey design intent

with richer amounts of information and instructions.

Jump ahead in time to the twentieth century. The use of steel

had been fully embraced, allowed buildings to reach higher than

ever before; the age of the skyscraper and modern construction

was in full force. Kansas City, Missouri, 1931. The Power and

Light Building (Figure 1.2) was erected in only 19 months. An art

deco testament to the boldness of the times, the building was built

without the use of modern earth-moving machinery or other

heavy equipment. The drawing set for a building of this size in the

1930s would have been about 30 pages long. The Power and Light

Building was more complex than its predecessors but far simpler

than today’s large commercial projects. There were no data or

telecom systems, no air conditioning other than operable win-

dows, and no security systems other than locks on the doors.

Fast-forward to the present day. Buildings are more complex

than ever before. Documentation sets span all disciplines, and are

hundreds of pages long. The number of people that will touch a set of drawings—to pro-

duce them, evaluate them, or use them to build the building—has become huge. Integrated

building systems continue to expand with the growth of technology. Today, we have more

security, electrical, data, telecom, HVAC, and energy requirement than ever before. (see

Figure 1.4). The amount of information that goes into a documentation set can no longer

be thought of as abstract approximations. The cost of error is too high, and the production

of coordinated drawings has become the staple of the profession. The use of computer-

based technology has replaced the use of pen and paper, yet remains a largely a 2 D repre-

sentational system. Drawing and editing lines has become faster and more efficient, but in

the end, they are still collections of manually created, non-intelligent lines and text.

Figure 1.3

The founders and

some original mem-

bers of Revit tech-

nology, having a

tug-of-war at a

release party, 

circa 2000.
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Figure 1.2

Power and Light

Building, Kansas

City, MO
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1998—dawn of the Internet boom. Technology companies are flourishing, and start-

ups are a dime a dozen. In the suburbs of Boston, a new approach to architectural docu-

mentation is about to be launched. The premise is simple: Model the building once, and

let architects view, edit, and annotate the model from any point of view, at any time. A

change to the model from any view simultaneously updates all other views. Drawings

cease to be separate, uncoordinated collections of lines, and become by-products of a

model-based design approach. Revit is born, and with it the foundation for a new approach

to how buildings are designed, evaluated, represented, and documented. Welcome to the

world of Building Information Modeling.

Advantages of a BIM Approach
The ultimate benefits of BIM are still emerging in the market, and will radically change the

way buildings are designed and built. A shift in process and expectation is happening in

the construction market, and architects are stepping up to the challenge. The focus is

shifting from traditional 2D abstractions to on-demand simulations of building perform-

ance, usage, and cost. This is no longer a futuristic fantasy, but a practical reality. In the

age of information-rich digital models we can now have all disciplines involved with a

project sharing a single database. Architecture, structure, mechanical, infrastructure, and

construction are tied together and able to coordinate in ways never before possible. Mod-

els can now be sent directly to fabrication machines, bypassing the need for traditional

shop drawings. Energy analysis can be done at the very outset of design, and construction

costs are becoming more and more predictable. These are just a few of the exciting oppor-

tunities that a BIM approach offers. 

BIM has shifted how designers and contractors look at the entire building process,

from preliminary design through construction documentation, into actual construction,

Figure 1.4

Layers of design
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and even into post-construction building management. With BIM, a parametric 3D

model is used to autogenerate traditional building abstractions such as plans, sections, 

elevations, details, and schedules. Drawings produced using BIM are not just discrete 

collections of manually coordinated lines, but interactive representations of a model.

Working in a model-based framework guarantees that a change in one view will propa-

gate to all other views of the model. As you shift elements in plan, they change in elevation

and section. If you remove a door from your model, it simultaneously gets removed from

all views, and your door schedule is updated. This enhanced document-delivery system

allows unprecedented control over the quality and coordination of the document set.

With the advent of BIM, designers and builders have a better way to control and dis-

play information, with some added benefits. Some of the advantages that first-time users

can expect to realize are as follows:

• 3D design visualization of the building and its spaces improves understanding of the

building and its spaces and gives users the ability to show a variety of design options

to both the team and the client.

• Integrated design documents minimize errors in cross-referencing and keynoting,

allowing clearer, more precise documents.

• Interference checking permits the user to immediately see conflicts among architec-

tural, structural, and mechanical elements in 3D, and avoids costly errors on site.

• Automated schedules of building components (like door and room-area schedules)

are generated, improving visibility of costs and quantities.

• Material quantity take-offs allow better predictability and planning.

• Sustainable strategies enable you to design better buildings and make a better world.

How BIM Is Different from CAD
The key difference between BIM and CAD is that a traditional CAD system uses many

separate (usually 2D) documents to explain a building. These documents are created sepa-

rately and have no intelligent connection between them. A wall in plan is represented with

two parallel lines, with no understanding that those lines represent the same wall in sec-

tion. The possibility of uncoordinated data is very high. The change management created

by CAD is a tedious and error-prone process. BIM takes the opposite approach: It assem-

bles all information into one location and cross-links that data among associated objects.

(See Figures 1.5 and 1.6.)

By and large, CAD is strictly a 2D technology with a specific need to output a collection

of lines and text on a page. These lines have no inherent meaning, whether inside the com-

puter or on the printed sheet. CAD drafting has its efficiencies and advantages over pen

and paper, but is really just a simulation of the act of drafting. This form of drawing is

how architects and other designers have worked for the last couple of hundred years. 
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Historically, the designer drew a set of plans and then used those plans to manually derive

sections, elevations, and details. During the development of a project, if any of those items

changed, the designer had to modify each of the other drawings that were affected to take

the change into account. For a long time, this meant getting out an erasure and an erasure

shield, and spending days picking up changes. Today, you can use the Delete key, but the

goal is fundamentally the same. This is where BIM makes a significant departure from

legacy CAD platforms.

Figure 1.6

Typical BIM outputs

Figure 1.5

Typical CAD outputs
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The beauty of BIM is that it manages change for you. Unlike CAD, the intent of BIM is

to let the computer take responsibility for redundant interactions and calculations, provid-

ing you, the designer, with more time to design and evaluate your decisions. A core feature

of BIM is that it allows you to create and modify everything in one design context. The

system will propagate changes to all relevant views in the project. As you model in plan,

the elevations, sections, and details are also being generated. Where you make the change

is up to you, and the system will take care of the rest. With a BIM tool such as Revit, if you

change the size of a window opening in elevation, this change is made throughout the

entire model.

Here are a few other big differences between BIM and CAD:

BIM adopts a task-oriented rather than an object-oriented methodology. In CAD,
you draw two lines (objects) to represent a wall. In BIM, the task of creating a wall is
presented in the form of an interactive tool named create wall. This wall has prop-
erties like width, height, bearing or nonbearing, demolished or new, interior or
exterior, fire rating, and materials (such as boards or brick). The wall interacts with
other walls to join geometries and clean up connections, showing how the walls will
be built. Similarly, if you add a door, it’s more than four lines and an arc; it’s a door
in plan and elevation. Adding it to the wall automatically creates an opening in the
wall in all views where the door is visible. As we will discover, the tools available for
walls are specific to walls, allowing you to attach walls to roofs and floors, punch
openings, and change the layered construction of the wall. Again, all of these interac-
tions are not just properties, but focused on specific tasks associated with a wall
component.

BIM keeps you honest. An additional advantage of a BIM methodology is that you
can’t cheat your design. Because the elements have properties based on real-life prop-
erties, you’ll find it difficult to fake elements within the design. If you have a door in
plan, it automatically appears in the other associated views. In a CAD-based system,
this can be easy to overlook, because the door has to be manually transcribed from
plan to section and elevation. Because BIM is based on actual assemblies it’s very dif-
ficult to misrepresent dimensions or objects within the model.

BIM is more than a modeler. Other software packages, like SketchUp, Rhino, and
3ds Max, are excellent modeling applications. However, these modeling applications
don’t have the ability to document your design for construction, nor be leveraged
downstream. This is not to say these tools don’t play a part in a BIM workflow. Many
architects use these tools to generate concept models, which can then be brought into
a BIM application and progress through design, analysis, and documentation.

BIM is a data-driven design tool. BIM lets you create custom content and libraries
throughout the course of your project. It’s much more than a drafting application.
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BIM is based on an architectural classification system—not “layers.” Because a
building model is an assembly of meaningful, to-be-built objects, you control visibil-
ity and graphics of objects using a rational list of well-understood categories. This is
different from CAD, where every line belongs to a layer, and it is up the user to man-
age all these layers. For example, in Revit there is no way to accidentally place a
window into the “wall” layer. In a BIM world, layers become obsolete—after all, in
the real world buildings are not made of abstract color-coded layers.

Potential Hazards

One of the powers of Revit is the ability to work in a single-file environment where the

design and documentation of the building happens on a holistic model.. This can also be a

disadvantage if not taken seriously and given full consideration. Users who may be quick

to make changes without thinking how such a change will ripple through the model can

cause unintended problems if not careful. Revit is a parametric modeler—it creates rela-

tionships between building elements in order to streamline the design process. For example,

if you delete a Level from your model, then all the walls, doors, and furniture on that level

will also be deleted. Likewise, if you delete a wall, all the doors and windows in that wall

will be deleted. If you underlay the roof in your second floor so that you can see the extents

of the roof overhang, deleting the lines that represent the roof overhang actually means

deleting the roof! These are some basic mistakes that new users might encounter as they

re-adjust their mental model, and come to see the model as much more than lines, but

actual building elements. A nice consequence of this is that Revit will not let you leave ele-

ments floating around in an abstract 3D vacuum. You will not have views cluttered with

fragmented geometry from some other file, exploded blocks, or mysterious lines. At the

same time, you must take care when making large-scale changes to a model, especially the

further along in the design process you go.

Anticipate that tasks will take different amounts of time when compared to a CAD pro-

duction environment. It isn’t an apples-to-apples equation. You’ll perform tasks in Revit

that you never had in CAD; conversely, some of the CAD tasks that took weeks (chamfer-

ing and trimming thousands of lines to draw walls properly or making a door schedule)

take almost no time using Revit.

If you’ve never worked in a 3D model–based environment, it can be frustrating at first

to move from a strictly 2D world to a 3D one. At the same time, it’s really quite nice to

have immediate access to perspective views at any time! The Revit world is one with a

white screen, no layers, and no x-references. This often leads to generic comparisons and

some growing pains, but just stick with it, be patient, and you’ll be hooked in no time at

all. With any transition there is a learning curve; as you begin to use Revit you’ll quickly

see the benefits.
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Why Revit?
Revit is the newest and most technologically advanced BIM application. Currently, a

number of BIM applications are on the market, provided by a host of different software

vendors. Although most other products in today’s market are based on technology that is

20+ years old, Revit was designed from the ground up as a BIM tool to specifically address

problem areas of the architecture, engineering, and construction (AEC) industry: commu-

nication, coordination, and change management. As you complete more projects with

Revit, you’ll begin to understand some of its advanced functionality. Being able to go direct

to fabrication with your designs, provide digital shop drawing submittals, and execute 4D

construction planning are just a few of the possibilities.

Revit is a technological platform that supports architectural, structural, and mechanical

disciplines. It’s supported by a patented parametric change engine that is unmatched in

sophistication. It’s also the leading software package in the international market. It’s not

the only package out there, but it offers the most holistic approach.

Revit Concepts
Revit comes from Revise Instantly and is built for managing change, something that we

have to do in our practice all the time.

Parametric Objects and Parametric Relationships

We all hear about parametric objects, but what makes an object parametric? A parametric

object is a smart object that can change its size, materials, and graphic look but is consis-

tently the same object. For example, think of a door. A single flush door can be 32˝, 34˝,

or 36˝ (70, 75, 80, 85, or 90cm). It can also be painted or solid wood. All of these sizes and

colors can be part of the same door family, with different parametric values applied.

Or consider a table—it can be the same shape but made out of wood or metal, with a

glass or wood top, and with the top extending over the legs or flush with them. Again,

they’re all in the same table family; only the parametric values are different. The parame-

ters are meaningful ways to create variations of an element. And most importantly, this

information is always accessible, reversible, editable, and schedulable.

In most CAD systems, to accommodate all these doors, you need to make not only a

separate block for each representation (thus, plan, elevation, and section typically com-

prise 7 or 8 blocks) but also as many blocks as sizes you need. If you then wish to make a

table that is 4´-0˝ square (50/50) to 5´-0˝ square (70/70), you use the scale command that

unfortunately makes the table legs bigger than needed because they resize along the table

top! A parametric object allows you to affect a change on each parameter without affecting

the others unless desired. So, you can change the size of the table legs independent from the

table top, and so on.
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Bidirectional Associativity

Objects with parameters that can be edited are nothing new in the world of software. But

what makes Revit unique is its ability to create relationships between objects. This ability

has been referred to as the Parametric Change Engine, and is a core technological advan-

tage built into Revit. Walls, for example, can be attached to roofs. If the roof changes to a

new shape or size, all walls attached to the roof automatically adapt to the roof shape.

Walls, Floors, Roofs, and Components all have explicit relationships to Levels. If a Level

changes height, all elements associated with that level will update automatically. When

you change the size of a room by moving walls, you are changing not only the wall, but

everything that wall effects in the model: the size of the room, color-fill diagrams, ceilings,

floors, and the doors and windows in the wall, and any dimensions to that wall. 

The parametrics are extended to annotations and sheet management as well. Tags are

not simple graphics with a text notation: They are interactive graphical parameters of the

element being tagged. To edit a tag is to edit the element, and vice versa. When you're lay-

ing out sheets and a section view is placed onto a sheet, the section key automatically refer-

ences the sheet number and detail number on the sheet. Change the sheet number, and

the section tag updates instantly. This is what a real parametric engine is and what ensures

total coordination of your documentation. This parametric engine guarantees that a

“change anywhere is a change everywhere.”

You’ll learn a lot about this concept and the value of it by doing the exercises in this

book, but let’s start with a simple example. If you draw a wall in CAD and place a dimen-

sion, the dimension reads the length of the wall. If you change the length of the wall to 6´-0˝

(2.4m), the width dimension, because it’s associative, also changes to 6´-0˝ (2.4m). But

Revit goes even further: When you change the dimension to 4´-0˝ (1.5m), the wall length

changes to 4’-0” (1.5m). As you can see, dimensions in Revit not only report information,

but also drive the design and size of objects.

Embedded Relationships

Revit has embedded intelligent relationships among elements that are in logical relation-

ship so that when one is affected, all related objects follow the change. To illustrate this,

let’s try a smart move. Look at Figures 1.7 and 1.8. To make one of the rooms smaller and

move the south wall 3´-0˝ (1m), you pick the wall and drag it. The four walls perpendi-

cular to and intersecting this wall extend themselves, and the room area automatically

updates. All you do is move the one wall. There is no need to create complex window

selections, no need to use trim and extend tools, and no need to re-compute room areas.

Revit does all of this for you with a few simple mouse clicks.

Now, what if your client doesn’t want those other walls to lengthen or move? Making

this change is also easily done. To move just that one wall and not affect the contiguous

walls or areas, select the wall, and then select Options ➔ Disallow Join.
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If for some reason this automatic behavior is not to your liking—perhaps you are deal-

ing with a renovation, and do not want to have existing conditions be affected by new

construction—this is not a problem. Revit allows you to break the “smart” relationships if

needed. You can also lock elements into place to prevent unintended consequences. How-

ever, for the most part, you’ll find the default embedded behaviors make sense, and you’ll

even start to take them for granted once you get into the swing of things.

User-Defined Rules

During the design phase, you may want to maintain some dimensional rules and make

sure these are not violated. Things like keeping the structural gridlines fixed or keeping 

a hallway a fixed width are some typical examples. You want to lock this rule down, and

keep it persistent as the design evolves. These design rules are used all the time, but not

many software applications let you capture this design intent and apply it in the model.

For instance, you want your door jamb positioned always at 4˝ (25cm) from the wall cor-

ner; you want the three windows in a room to be always positioned at equal distances;

Figure 1.8

The same floor 

plan after moving

the wall

Figure 1.7

The floor plan

before the change
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you want the sill height for your windows to always be 4´-0˝ (1.20m) above the floor. You

want the rules/relationship to be remembered regardless of how many changes occur in

the design process. Revit allows you to define and lock these relationships with constraints:

explicit dimensional rules that keep elements locked to one another.

Types of Elements in Revit
Every parametric object in Revit is considered a family. In this section, we’ll discuss how

Revit organizes data. Then we’ll explain the available types of families, the principles of

their behavior, how to create them, and where to find them. The categories are divided

into two primary buckets: Model categories and Annotation categories.

How Revit Organizes Data

Revit uses a building-industry-specific classification to organize all the data in the model.

This system of organization manages relationships among classes of elements as well as

their graphical display. At the top of this organization is a fixed list of categories into

which all elements are grouped.

Model Categories

Model categories include all representations of physical object types that are typically

found in buildings. This includes 2D elements that are used to add more detail to the

model, such as floor patterns and ceiling hatch. For elements that don’t fit into Revit’s 

categorization system, the Generic Model category can be used.

Annotation Categories

Annotation categories are all the annotations, symbols, and 2D data added to a view to

describe how the building is to be constructed. For example, all walls in a project are

members of the model category Walls, and all wall tags are members of the annotation

category Wall Tags. Annotation categories also include 2D graphics that are overlaid on

the model in order to convey additional information about the model. These annotations

are view-specific and appear only in the view they were created in. The one exception to

this rule is entities created in dependent views. Examples include dimensions, tags, call-

outs, section marks, and text notes.

To view all the model and annotation categories, go to Settings ➔ Object Styles. The

table of categories is shown in Figure 1.9

Annotation categories don’t appear in 3D views.
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Below each category can be many subcategories. If Door is the main category, the ele-

vation swing, frame/mullion, glass, opening, panel swing, and any other user-defined

elements that can be made when creating the door are listed. The beauty of this system

is that you can control the visibility of each subcategory independently. So, in our door

example, you can turn off the door leaf and still see the frame, mullions, and glass. As

Figures 1.10 through 1.12 show how different sub-components of a door can be turned

on and off in a view.

Figure 1.12

Same door with the panel subcategory

turned off

Figure 1.11

The door with hardware subcategory

turned off

Figure 1.10

A door family

Figure 1.9

The Object Styles

dialog sets the

graphics for all 

categories and 

subcategories 

in the project
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Controlling the Visibility of Elements in Revit

As you learned earlier in this chapter, there are no layers in Revit. You may be asking

yourself, “Just a second! How will I live without layers?”

Let’s look at the origin of layers. In the predigital era (and still, in some offices) projects

were drawn manually on translucent paper called trace. Multiple layers of paper were

stacked and shuffled to create different representations of the same plan. Furniture might

go on one sheet, mechanical systems on another, and so forth. In a paper-based workflow,

to make a change, you erased something on one sheet and redrew it on another.

CAD applications employ a digital version of trace to control the visibility of elements.

Their digital layers allow you to move an element from one layer to another.

Instead of using layers, Revit uses object categories. For example, instead of putting

door handles on their own layer so they show only in certain views, Revit has commands

to control the visibility of elements. If you don’t want to show the glass in windows, doors,

or curtain walls, you can turn them off in the view.

Families in Revit

Independently of whether it’s a model or annotation category, a Revit family can be a sys-

tem family, a standard family, or an in-place family.

System Families

Examples of system families are walls, roofs, stairs, railings, ramps, and mullions. To cre-

ate such a family, you need to duplicate an existing family of the same type and modify it.

So to create a new wall type, you must duplicate an existing wall. To reuse system families

from one project to another, select File ➔ Transfer Project Standards.

Figure 1.13

The Visibility/

Graphic Overrides

dialog controls 

visibility of cate-

gories on a 

view-by-view basis
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Examples of system families include walls, roofs, stairs, railings, and ramps. To create new

types of System Families with unique properties, you duplicate an existing type, and then

modify its properties. This method of duplicating a type to create new types is used frequently

in Revit, so get use to this concept. While you cannot save a system family to a shared library

as a standalone component, it is possible to transfer these families between projects. We’ll go

into more detail about creating and using system families later in this book.

We’ll go into more detail about creating and using system families later in this book.

Standard Families

Standard families are created outside of the project environment—still in Revit, but in a

specific environment called the Family Editor, designed for creating library objects. Sys-

tem families have their own file format extension (.rfa) and can be stored or edited as sep-

arate files outside of a model and loaded at any time into the project.

To see how Revit organizes family objects, choose File ➔ Load Library ➔ Load Family.

You’ll see the folders in which these families are stored.

To create a new standard family, you can either duplicate an existing one and modify it

in the Family Editor or create a new one, using the family templates included with each

copy of Revit. Revit doesn’t require you to know any programming or scripting language

in order to create new smart, parametric families. This is an important advantage of Revit.

To open a template, choose File ➔ New ➔ Family. Embedded in each template are smart

behavior characteristics of the family you’re creating. Doors, windows, balusters, casework,

columns, curtain wall panels, entourage, furniture, massing elements, generic objects, and

plantings are all examples of standard Revit families.

In-Place Families

In-place families are custom objects that are specific to a certain context within the model.

A complex sweep as a railing fence on a site is an example of an in-place family.

Tips for Getting Started in Revit
Knowing how and where to begin your journey can be a challenge, and we want ot give

you a few pointers. Although this list isn’t complete by any means, it should help steer you

in the right direction:

Begin with the end in your mind. When you begin any project, planning is always a
good way to start. You can set yourself up for a successful implementation from the
beginning by using a bit of forethought about your process, workflow, and desired
outcome.

Get your project and office standards in place early. As design professionals, we
have a tendency to develop unique graphic conventions and styles for our documents.
This is a specific area where good planning leads to a good project. If possible, get
your standards in place before you begin a project. Revit does an excellent job of
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getting you started with a good template of graphic standards to work with. However,
if you’re like most architects, an application right out of the box is never quite nice
enough. Revit provides a good starting point for customization, and with some up-
front time, you soon can have your project and office standards up and running.

Remember that the first project you do in Revit is a change in methodology.
You’re leveraging technology to help you change the way you approach design and
documentation. Don’t expect the process to have the same workflow as it did in a
CAD-based system. Try to stay flexible in your expectations and schedule, and allow
yourself time to adapt to the change. 

Don’t try to conquer the world on the first project. There are many advantages to
using BIM as a design and documentation methodology. As this process becomes
more mainstream within the industry, those benefits will only increase. All of these
things and more are possible with the use of Revit, but it will take a couple of proj-
ects to get there. Tailor the use of BIM to the project, and use the features that will
maximize the benefits of using BIM. Choose your goals realistically based on the
expertise of your project team, and plan in advance so those can be successful.

Model correctly from the beginning. We can’t stress this enough. As you refine
your design, it’s critical to begin modeling correctly from the beginning so you don’t
have to fix things later. What does this mean? As an example, think of your wall.
Does it sit on the floor, or does the floor attach to the wall? If you can begin to think
about how your project will be assembled, it will save you a lot of time at the end.
It’s good practice to plan ahead, but remember that Revit will allow you to make
major changes at any stage in the process, and maintain coordination.

Get information into the project as soon as it becomes known. A key advantage 
of using Revit is the ability to change your project schedule. In a traditional design
process, most of the effort on a project is realized during the construction-document
phase. At that time, a typical project has the most staff working on the project, and it
can be fairly difficult to implement major changes to the project design. This is due
to the complexity of the documents by this time and the amount of effort for the
team to redraw all the changed information. You’ll find that with Revit, design change
is largely managed by the software itself. This gives you a great deal of flexibility in
both your design and documentation. Take advantage of this shift in the process,
and add information to your model early. It can be in the form of more detailed
content or show the material construction of your wall system. Remember that you
can change all this information much more quickly and easily than you ever could in
CAD, so don’t assume you’re locked into the information you displayed early in the
design process.

One of the most important rules to follow as you begin your project is to model the building

as it will be built, and keep in mind that you do not need to model every condition three-

dimensionally.
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Plan for better communication among team members early in the process.
Communication within a team is critical for understanding a project and document-
ing it successfully. One of the downfalls inherent in a CAD-based system is that there
is no connection between the different files that make up the drawing set. This phe-
nomenon carries through to the project team and is a function of project workflow
and project management. In CAD, it’s possible for team members to work in some
degree of isolation. They aren’t forced to immediately reconcile their changes with
changes made by their teammates. Revit’s single-file environment forces a much
higher degree of team communication between not only the architects, but also your
structural and mechanical engineers.

Don’t try to model everything. Most of us have drafted in a 2D environment until
now. Moving to a 3D world is a significant change. Do you have to model every single
screw? every mullion? every stud? That’s a good question. The simple answer is no,
you don’t have to, and in fact you should not attempt to do so. Like any BIM sys-
tem, Revit isn’t 100 percent 3D information. Typical workstations aren’t capable of
handling all the data of a building in model form. Additionally, few projects have the
time in their schedule to model the screws in a sheet of gypsum board or the sealant
around all the windows; some of that information is best presented in 2D or in the
specifications. This still leaves you with a wide range of options for modeling. In the
beginning, err on the side of simplicity. It’s far easier to add complexity to your
model later on as you gain experience and confidence than it is to troubleshoot
over-constrained parameters early in the process. Start with the big ideas: walls,
openings, roofs, and so forth. Work your way down to a comfortable level of detail
for both you and your computer.

Organize your team. A BIM project team includes three basic technical roles. These
roles are interchangeable, especially on smaller projects with fewer team members.
However small the team, it’s useful to make sure all these roles are filled:

• Content/Family Creator—The Family Creator’s primary role is to create the

parametric content in the Revit model. This is typically someone with 3D experi-

ence who also has a firm understanding of Revit and Revit families. The families,

as you’ll see later, have parameters that can control visibility, size, color, propor-

tion, and a number of other things.

• Designer—This is the person or team whose primary responsibility is to figure

out what the project will look like and how it will be made. They create walls,

floors, and roofs, and locate windows, doors, and other building elements.

• Documenter—This role supplies the bulk of the documentation. It consists of

drafting some of the 2D linework over portions of the 3D model to show detail,

adding annotations and keynotes and creating details.
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Ask for help. If you get stuck along the way, don’t assume you’re alone. There are
myriad resources to help you find a specific solution to your problem. Chances are,
someone has tried the same thing before. In our digital age, a wealth of information
is available online, so before you spend hours trying to work through a particular
problem, try tapping some of the existing resources:

• Revit Help menu—Your first stop, if or when you get stuck, should be the Revit

Help menu. It’s one of the easier and more robust Help menus out there, and it

can give you a lot of useful information very quickly. It’s also the most accessible

help source. As with most applications, it’s at the far right of the menu bar.

• Subscription Support—If you have bought Revit on subscription, Revit Subscrip-

tion Support offers an exemplary web-based support system. Their responses are

speedy, and their advice is top-notch. If you need information more quickly,

Revit also has an online knowledge base of FAQs that is available without a sub-

scription. Both of these resources can be accessed at www.autodesk.com/revit.

• AUGI—Autodesk User Group International (AUGI) is also an excellent source

for tips and tricks. It’s an online service managed by Autodesk and is free after

you register on the site. It has a host of information and forums populated by

others in the industry. Because it’s a forum, you can post and answer questions

or engage in discussions surrounding an array of topics. The address is

www.augi.com.

• Revit City—Looking for content and families? Revit City, another free online

service, has a growing database of free families posted by other users. Its address

is www.revitcity.com.

• Autodesk Discussion Groups—These pages offer insightful discussions and some

great Q&A threads: http://discussion.autodesk.com/

• Revit OpEd—A blog with some great information, useful links, and helpful tips

and tricks. Put together by a longtime Revit guru, and fellow author, Steve

Stafford: http://revitoped.blogspot.com/

• AECbytes—A website dedicated to following and reporting on the trends in the

the AEC industry, with a strong focus on BIM, technology, and the direction 

of the industry. Put together by Lachmi Khemlani: http://www.aecbytes.com/
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